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Accessibility

SAS IT Resource Management 3.1.1 includes the following accessibility and
compatibility features that improve usability of the product for users with disabilities.
These features are related to accessibility standards for electronic information
technology that were adopted by the U.S. Government under Section 508 of the U.S.
Rehabilitation Act of 1973, as amended.

SAS IT Resource Management 3.1.1 addresses two areas of 508 compliance:

0 Web accessibility compliance applies to browser-based content and Web-based
applications.

0 Software accessibility compliance applies to software. In SAS IT Resource
Management 3.1.1, software accessibility compliance applies to the SAS Data
Integration Studio user interface. SAS IT Resource Management 3.1.1 uses the
functionality of SAS Data Integration Studio and as such has the same accessibility
features as that product. For information about these features, see SAS Data
Integration Studio: User’s Guide. This documentation is located at this address:
http://support.sas.com/documentation/onlinedoc/index.html.

If you have questions or concerns about the accessibility of SAS products, send e-mail
to accessibility@sas.com.

Accessing SAS IT Resource Management 3.1.1 Documentation

SAS IT Resource Management 3.1.1 uses the data integration and business
intelligence functionality of the SAS Intelligence Platform. It supports a flexible
multi-tier architecture. Like earlier versions of the software, the SAS IT Resource
Management server runs on z/OS, UNIX, and Windows servers and the client
components run in Windows desktop operating systems. The new SAS IT Resource
Management middle tier runs on Windows and UNIX server environments.

SAS IT Resource Management provides other resources to assist you in using this
product and in managing your IT resources. For information about these resources, see
“Other Resources” on page 53.

Documentation about SAS IT Resource Management 3.1.1 is available in the form of
online Help and also as Web-based, PDF documentation.
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0 Online Help

This documentation is available for anyone who performs tasks with the user
interface:

0 SAS IT Management Solutions Help and SAS IT Resource Management Help

In addition, as with all SAS products and solutions, online Help is available for
all SAS technology products on which SAS IT Resource Management 3.1.1 is built.

0 The following Web-based PDF's can be accessed from
http://support.sas.com/itrm.

This documentation consists of the following:
o Introduction to SAS IT Resource Management

This document provides an overview of SAS IT Resource Management
3.1.1. It contains general information about the architecture of the software,
the software components included, and the personas who use the software. It
introduces the reader to the IT data mart, the adapters that stage the
resource data, and the aggregation transformations that aggregate the data
and prepare it for reporting. It also provides a general description of the
reporting function.

The audience for this introductory document is anyone who works with
SAS IT Resource Management 3.1.1 or who uses the reports that are
generated by the software.

0 SAS IT Management Solutions: Administrator’s Guide

This document contains detailed information about the tasks that are
required to set up and manage the IT data mart. It also describes how to set
up the IT Resource Management adapters so that they can process the IT
resource data that is stored in the IT data mart. This guide provides
information about how to work with simple and summarized aggregations.

The Administrator’s Guide provides information about the other
functional components of the software, such as the SAS Metadata Repository
(SMR), information maps, and the like.

The audience for the Administrator’s Guide consists of anyone who
works with SAS IT Resource Management 3.1.1 as a data administrator or
capacity planner.

0 SAS IT Resource Management: Migration Documentation

This document provides a description of the steps that are performed in
order to move a site’s processing from the earlier version of the software (SAS
IT Resource Management 2.7) to the current version.

Documentation is available for the business intelligence and data integration
components of the SAS Intelligence Platform and all the SAS products that are
referenced in this product. To access this documentation, navigate to the Web site at
this location: http://support.sas.com/documentation/onlinedoc/index.html. On
this page, use the select a Product drop-down menu to choose the documentation for
the product or solution that you want to view. Then click Go.

SAS IT Resource Management Users

SAS IT Resource Management documentation is intended to address the needs of
particular groups of people, based on their roles and on the tasks that they perform.
Some organizations have different individuals performing the duties of each of these
roles; others are organized so that one person handles several roles.
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The documentation for this product is written for the following types of users:

Data
Administrators

Power Analysts

Information
Consumers

These users are responsible for building and managing the IT data
marts, setting up adapters, handling the extract, transform, and
load (ETL) processes, and preparing the data for reports. They often
function as IT performance managers and capacity planners.

In general, data administrators work with the following products:
Base SAS, SAS Management Console, SAS Data Integration Studio,
SAS Information Map Studio, and SAS Information Delivery Portal.
In addition, data administrators work with the job scheduler for
their operating environments.

These users are the people who understand how to analyze the IT
resource measurement data that is managed by data administrators.
They analyze this data in order to best benefit the business and to
improve the utilization, availability, and performance of IT resources
and the IT enterprise. They often function as capacity planners,
system administrators, and business analysts. Their job
responsibilities require them to design, generate, and view reports.

In general, power analysts work with Base SAS, SAS Enterprise
Guide, SAS Information Map Studio, SAS Web Report Studio, and
SAS Information Delivery Portal.

These users are high-level business people who are interested in the
overall performance aspects of IT at a company. They often function
as corporate IT executives. They use the reports that are generated
by SAS IT Resource Management to support executive-level
decision-making. They need to access the reports from the office as
well as from remote locations.

In general, information consumers work with Web Report Studio,
SAS Add-In for Microsoft Office, and SAS Information Delivery
Portal.
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The following table summarizes each role and the documentation that is applicable to
support the functions that are associated with that role.

Table 1.1 Documentation That Is Useful per Role

This Person Uses This Documentation
Data Introduction to SAS IT Resource Management
Administrator

SAS IT Resource Management: Administrator’s Guide
Online Help for SAS IT Resource Management
Online Help for SAS IT Management Solutions
Online Help for SAS Data Integration Studio

SAS Data Integration Studio: User’s Guide

SAS Information Map Studio documentation

SAS Information Delivery Portal documentation

SAS Intelligence Platform: Administration Guide, which contains information
about SAS Web Report Studio

SAS Management Console: User’s Guide

Other SAS documentation as required

Power Analyst  Introduction to SAS IT Resource Management
Online Help for SAS Enterprise Guide
SAS Enterprise Guide documentation
SAS Information Map Studio documentation

SAS Intelligence Platform: Administration Guide, which contains information
about SAS Web Report Studio

SAS Web Infrastructure Kit: Developer’s Guide, which includes documentation
about SAS Information Delivery Portal

Other SAS documentation as required

Information Introduction to SAS IT Resource Management

Consumer SAS Intelligence Platform: Administration Guide, which contains information

about SAS Web Report Studio

SAS Web Infrastructure Kit: Developer’s Guide, which includes documentation
about SAS Information Delivery Portal

Other SAS documentation as required
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Overview of SAS IT Resource Management

The effective management of IT resources is a critical function for today’s businesses.
An IT department must manage and plan the usage of its resources so that it can
provide a stable yet scalable information processing environment for its current and
future operations. An IT department must also provide enough information about the
performance of IT resources so that the enterprise’s decision makers can make the right
decisions, keeping the business competitive and responsive to its customers. To
accomplish these objectives, IT managers need to access, manage, integrate,
manipulate, and analyze large quantities of performance data about many resources,
such as hardware, operating system software, networks, Web servers, databases, and
applications. The IT performance data is generated by the logging mechanisms that are
inherent to IT resources or is created by the Enterprise Systems Management tools that
are used to manage the IT infrastructure. IT performance evaluation software requires
technology that can work with performance data from these many different sources,
summarize and analyze that data, and provide reports that permit quick and accurate
analyses of a company’s IT resources from both current, historical, and forecasted
perspectives.

The SAS solution to this critical business challenge is SAS IT Resource Management.
SAS IT Resource Management can be used to resolve a variety of systems management
challenges within an organization. It provides the functionality to do the following
tasks:

0 Establish IT data marts that contain all the resource management data that is
associated with an enterprise.

o0 Define aggregation transformations that are specific to a site’s reporting
requirements.

0 Create common references to common measurements that are available in
disparate data sources in order to ensure that the IT data mart provides an
independent set of measurements that can be analyzed across the IT enterprise.

o Provide graphical and textual reports that contain all the information that is
needed to manage current day IT operations.

o Use SAS IT domain knowledge for performance management, capacity planning,
IT resource forecasting, peak period and seasonality analysis, workload analysis,
and enterprise IT performance summaries that complement existing IT utilization,
availability, and performance analysis capabilities.
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0 Provide a variety of report output mediums to accommodate the needs of the data
administrators, power analysts, and high-level information consumers.

To satisfy these requirements, SAS IT Resource Management supports many popular
network and systems management tools across the Windows, UNIX, and z/OS operating
environments. It also takes advantage of SAS®9 and the enterprise-class solutions that
SAS®9 provides, such as:

0 SAS Data Integration Studio

This solution provides flexible data integration services for most data sources.
These services perform most of the data preparation and aggregation work that is
needed to analyze and report on resource performance. These services enable you
to perform the following tasks:

O Create and maintain the IT data marts that are the containers for the
information maps, the extract, transform, and load (ETL) jobs, the tables, the
templates, the data, and the libraries that are created by or used by SAS IT
Resource Management.

0 Create and run the processes that stage data in preparation for use by the
aggregation transformations.

0 Calculate new fields of data from the input data.
0 Create and run the processes that aggregate the data.

O SAS Statistics and Econometric Time Series

This solution provides a complete set of SAS statistical methods for IT data
analysis.

0 SAS Enterprise Guide

This solution provides comprehensive reporting definition services. Report
definitions that are created in this solution can be run interactively within SAS
Enterprise Guide, or they can be scheduled to run in batch mode.

O SAS Business Intelligence Platform

This platform uses the SAS Foundation technology, which includes the following
software: Base SAS, SAS/GRAPH, SAS/STAT, the Output Delivery System (ODS),
and other technologies. It also uses the following components:

0 SAS Information Map Studio: This product provides the functionality that is
necessary to design reports using business-oriented terminology.

0 SAS Metadata Repository: This repository of centralized metadata stores
information about the objects that are created and used by SAS IT Resource
Management, such as IT data marts, ETL jobs, information maps, report
jobs, and more.

0 SAS Web Report Studio: This Web-based, interactive query and analysis tool
simplifies and standardizes access to and reporting of performance evaluation
information.

0 SAS Information Delivery Portal: This open Java portal is a customizable
portal that provides corporate decision makers with easy access to the data
that is most pertinent to them by means of reports and dashboards, such as
key performance indicators (KPIs), filter reports, and more. SAS Information
Delivery Portal enables the selective and secure dissemination of information
throughout an organization.

0 SAS Add-In for Microsoft Office: This product enables integration with
commonly used Microsoft products such as Microsoft Word and Microsoft
Excel.

For a more detailed list of the components that constitute SAS IT Resource
Management, see Appendix 3, “Required Components,” on page 59.
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Stepping through the SAS Solution

SAS IT Resource Management provides the processes and the supporting technology
that are required to regularly collect, aggregate, and report on the IT performance
evaluation data that is vital to the health of an enterprise. A general description of
these processes and the technology that supports these processes is available in the
remainder of this document. More detailed information about how to manipulate the
supporting technology is available in the SAS IT Management Solutions:
Administrator’s Guide.

To start SAS IT Resource Management 3.1.1 from the Windows Start menu, select
Programs » SAS » SAS Data Integration Studio.

In general, the processes that gather and monitor IT performance evaluation data
consist of these steps:

1 Collect the raw data about a resource.

IT performance data is information about IT resources, such as hardware,
operating system software, networks, Web servers, databases, and applications.
Raw (or unprocessed) data about the usage or performance of these resources is
generated by the logging mechanisms that are inherent to IT resources or is
created by the Enterprise Systems Management tools that are used to manage the
IT infrastructure. The raw data is input to SAS Data Integration Studio
transformations that are supplied with SAS IT Resource Management software.

2 Process (stage) the raw data.

The raw data is processed (or staged) by adapters that are tailored to the data
sources that they process. The adapter’s staging code performs functions such as
normalizing measurement units, generating computed columns from the raw data,
and checking for duplicate data. Staging is performed by transformations that are
set up in SAS Data Integration Studio. The job that actually executes the
transformation can run interactively or can be scheduled to run in batch mode,
depending on the requirements of your enterprise.

A unique staging transformation is supplied for each adapter that is supported
by SAS IT Resource Management. It contains the code and the associated
templates that are needed to process and load the raw data into staged tables that
can be used as input to an aggregation transformation or other SAS Data
Integration Studio transformations.

For a list of the adapters that are supported by SAS IT Resource Management
3.1.1, see “Types of Adapters” on page 32.

Note: For more information about user-written adapters, see SAS IT
Management Solutions: Administrator’s Guide that is located here:
http://support.sas.com/itrm. A

3 Aggregate the staged tables.

After the raw data is staged, it can be input to the aggregation step.
Aggregation transformations can generate summarized aggregation tables or
simple aggregation tables. Simple aggregations read data from the staged table
and append that new data to an existing table without undergoing any
summarization. Summarized aggregations read data from the staged table and
then categorize and aggregate that data according to the specifications of the
aggregation transformation. Aggregation transformations are created, updated,
and scheduled for execution in SAS Data Integration Studio.
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An aggregation transformation can contain multiple aggregations that each
generate an aggregated table of data. SAS IT Resource Management provides the
ability to customize aggregations based on a site’s requirements. Aggregations can
be customized to perform multi-step calculations that calculate additional columns
of data or support any time periods that are needed. An unlimited number of
aggregations can be created for each staged table. For example, the same data
source can be input to both a daily aggregation and a weekly aggregation within
the same or separate aggregation transformations.

After the performance data has been aggregated, it is ready for the reporting
processes.

Generate information maps.

For a supported adapter, SAS Data Integration Studio generates
transformations that create information maps that reference the tables of data
that are generated by that adapter’s aggregation transformations. Information
maps provide clearly labeled references for all data fields that are used to create
and view reports. Information maps can be used in SAS Enterprise Guide and
SAS Enterprise Business Intelligence applications such as SAS Web Report Studio
in order to generate reports that provide domain intelligence about the adapters,
such as CPU utilization, threshold analysis, and peak period analysis.

5 Define the reports for the summarized data.

SAS Enterprise Guide can generate tabular and graphic reports by using
information maps or by directly accessing data in the aggregation tables. SAS
Enterprise Guide can also be used to create stored processes. Stored processes are
SAS programs that can contain instructions for rendering report elements as part
of a larger report. They can also render complete reports that include queries,
prompted filters, titles, images, and statistical analyses. Stored processes can be
executed by client applications such as SAS Web Report Studio.

Report definitions can be run from SAS Enterprise Guide and the resulting
reports can be viewed interactively from the SAS Enterprise Guide Project window.

Use ad hoc reporting.

Ad hoc reporting of a company’s performance data is provided through SAS Web
Report Studio, which is a Web-based interface that can access data directly or that
can use information maps to select and report on data. Information maps are
generated by the information map transformations. They present to the
information consumer and power analyst a logical, business-oriented
representation of data. In other words, by using SAS Web Report Studio with an
information map, an information consumer or a power analyst does not have to
understand the physical table names and fields that are associated with the data
that is being manipulated. Instead, these people can quickly and easily create and
view reports that communicate utilization, availability, and performance
intelligence for IT resources and the IT enterprise.

Use Microsoft Office products.

SAS Add-In for Microsoft Office enables SAS functionality to be accessed
directly from the menus and toolbars of Microsoft Office word processing and
spreadsheet products.

Power analysts and information consumers who frequently work with Microsoft
Office products such as Microsoft Word and Microsoft Excel can use SAS to access,
analyze, and report on IT performance data that is available in information maps,
and then distribute the results to other people in the enterprise.

View the reports.

The reports that have been generated can be viewed on the Web through SAS
Information Delivery Portal.
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For more detailed information about these procedures, see the SAS IT Management
Solutions: Administrator’s Guide that is located here:
http://support.sas.com/itrm.
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About the SAS Intelligence Platform

SAS IT Resource Management 3.1.1 runs on and uses the functionality of the data
integration and business intelligence components of the SAS Intelligence Platform. The
SAS Intelligence Platform is a comprehensive, end-to-end infrastructure for creating,
managing, and distributing enterprise intelligence. It offers a fully integrated suite of
software that can process input data from most sources, manage and analyze that data,
and display the data by means of reporting and delivery tools.

It includes tools and interfaces that enable data administrators, information
producers, and information consumers to do the following:

O extract data from a variety of operational data sources on multiple platforms and
build a data collection that integrates the extracted data

O store large volumes of data efficiently and in a variety of formats

O give business users at all levels the ability to explore data from the warehouse in a
Web browser, to perform simple query and reporting functions, and to view
graphical and textual results of complex analyses

O provide business users with access to Microsoft Word and Microsoft Excel

o provide for the delivery and distribution of reports and other information by
means of a customizable Web-based portal

0 use high-end analytic techniques to provide capabilities for forecasting,
optimization, simulation, and experimental design

O centrally control and administer the enterprise data to ensure its accuracy and
consistency

O create and execute stored processes
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The SAS Intelligence Platform also supports the requirements of the comprehensive
SAS IT Resource Management application. To do so, it supplies additional processing
capabilities to one of the standard SAS business intelligence applications, primarily
SAS Data Integration Studio.

Note: For more information about the data integration and business intelligence
components of the SAS Intelligence Platform, see the documentation that is available
for this topic at this Web site:
http://support.sas.com/documentation/configuration/913admin.html. A

Using the Components of the SAS Intelligence Platform

Overview of SAS IT Resource Management Architecture

SAS IT Resource Management uses data integration and business intelligence
components that are provided by the SAS Intelligence Platform as well as additional
software that was designed specifically for the processing of IT resource data. At
installation time, users can deploy these components across multiple tiers. Using a
multi-tier architecture to separate major software functions supports flexible processing
schemes. The following functions can be supported on the tiers that SAS IT Resource
Management uses:

O The client tier provides the interface between the user and SAS IT Resource
Management. The client software enables you to perform data administration
tasks, build reports, and view reports.

0 The middle tier provides server support for Java applications.

0 The server tier provides services that access data and perform background
processing such as managing the metadata, executing stored processes, and
performing resource aggregation calculations. In addition, the files and tables that
are input to and generated by the software reside on the server.

With multi-tier processing, all tiers can run on a single machine. Alternatively, the
tiers can be separated so that the processing can be done on multiple machines.
Because the SAS IT Resource Management server can run in Windows, UNIX, or z/0OS
operating environments, its software components can be installed on different machines
according to the site requirements of an enterprise. For example, in a Windows
environment, all of the processes that are needed by SAS IT Resource Management can
be installed on a single PC. Other sites might prefer to install the client applications
and middle tier on a PC and install the remaining components on the mainframe.
Another option is to install the components needed for Web-based functions on a UNIX
processor. The SAS representative can discuss these options and ensure the most
appropriate configuration for a site.

The following diagram displays the architectural components that constitute the
clients, middle tier, and servers that are used by SAS IT Resource Management.
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Figure 3.1 Tiered Architecture of SAS IT Resource Management

Clients Browser/Thin Clients
Java Clients Microsoft Internet Explorer 5.5+
SAS Data Integration Studio SAS Web Report Studio
(with plug-ins for SAS IT Resource Management) SAS ID Portal
SAS Management Console <P
SAS Information Map Studio - -
SAS OLAP Cube Studio Windows Clients
SAS Enterprise Guide
SAS Add-In to Microsoft Office

Middle Tier
Web Application Servers
o SAS
Metadata
Tomcat, WebLogic, or WebSphere 4> Server

Note: Web Application Servers are used to support SAS Information Delivery Portal, SAS
Foundation Services, and SAS OLAP Viewers

Servers
SAS S?AS ; SAS/ SAS/ SAS
Workspace 5 ore CONNECT SHARE OLAP
Server* roces§ Server* Server Server
Server PEY

*For Base SAS, SAS/GRAPH, and other SAS components such as SAS/ACCESS products that
can access database management systems such as Oracle, DB2, and ODBC

SAS IT Resource Management Server

Note: The multiple tiers shown in this diagram represent categories of software that
perform similar functions. They do not necessarily represent separate processors. In
addition, your site might not need to use all of these software components. For
example, if your site does not use the SAS Add-In for Microsoft Office, you do not need
to install it. A

SAS IT Resource Management components are distributed across the client tier, middle
tier, and server tier as shown in the following sections.

The Client Tier

For SAS IT Resource Management, the client tier runs in Windows desktop operating
systems and hosts the following client applications:

0 Browser Client applications

0 SAS Management Console provides the data administrator with a single
point of access to the system management tasks that are required by SAS IT
Resource Management. It enables data administrators to perform the tasks
that create and maintain an integrated environment, such as managing
server, library, and user definitions. It also manages resource access controls,
metadata repositories, SAS licenses, job schedules, and XML maps.
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To perform these administrative tasks, SAS Management Console creates
and maintains metadata definitions, which are stored in a repository on a
SAS Metadata Server. From there, they can be accessed by other applications.

0 SAS Data Integration Studio with SAS IT Resource Management plug-ins is

the primary interface for the data administrator. It is a visual design tool
that enables data administrators or power analysts to construct, execute,
maintain, and reuse processes that manipulate data.

SAS Data Integration Studio provides extensive transformations for data
manipulation along with a single point of control for managing data
integration processes. It enables the data administrator and the power
analyst to define and execute jobs that process the raw data that has been
collected by external third-party software. These jobs consist of
transformations that input, stage, convert, and aggregate the data. SAS Data
Integration Studio can generate SAS code so that these jobs can be scheduled
and run in a batch environment.

SAS Data Integration Studio also enables the data administrator to create
new repositories.

o SAS Information Map Studio enables the data administrator and the power

analyst to define information maps that describe the variables that can be
used for analysis and reporting purposes. Information maps consist of
metadata that translates physical data into informative terms that can be
accessed and analyzed by business users.

Power analysts can use SAS Information Map Studio to modify the
information maps that were generated by the SAS IT Resource Management
plug-ins to SAS Data Integration Studio. By providing business users with a
nontechnical method for working with physical data, SAS Information Map
Studio enables them to create ad hoc reports without requiring assistance
from the IT department.

0 SAS OLAP Cube Studio provides a user interface for data designers who

design online analytical processing (OLAP) data sources. An OLAP cube
provides a hierarchical, multidimensional database structure that stores
summarized numerical information so that those values can be easily and
quickly accessed for queries and reports.

0 Installed applications
0 SAS Enterprise Guide is the primary tool for creating report definitions. SAS

Enterprise Guide is a Windows application that uses a wizard to provide
power analysts and information consumers with quick and easy access to the
SAS System. It enables users to create report definitions that access,
manage, transform, analyze, aggregate, and report on their data. With its
interface to SAS/GRAPH, SAS Enterprise Guide can generate definitions for
both textual and graphic reports.

The report definitions can be run interactively. Alternatively, the SAS
Enterprise Guide project or process flows within the project can be scheduled
to run in batch on your Windows environment. In addition, the stored process
server that is available in SAS®9 makes it possible for multiple users to
share the definitions, programs, and processes that have been defined in SAS
Enterprise Guide.

Note: SAS Enterprise Guide is an important part of the SAS Intelligence
Platform; it is available as a stand-alone product. A

SAS Add-In for Microsoft Office enables power analysts and information
consumers to access SAS functionality directly from Microsoft Office. By
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means of toolbars and menus, information producers and consumers can
access, analyze, and report on SAS data from toolbars and menus that are
integrated with Microsoft Office, thus extending the processing capabilities of
Microsoft Word and Microsoft Excel. In addition, stored processes that
execute SAS code can be executed from the Microsoft Office applications.

Microsoft Office can also be used to distribute the documents to the
relevant decision makers.

o0 Browser applications

0 SAS Web Report Studio enables power analysts and information consumers to
view, author, and share IT resource management reports on the Web. Users
can also create new reports, edit existing reports, and filter the results. In
addition, SAS Web Report Studio can execute stored processes that were
created in SAS Enterprise Guide.

This tool in conjunction with information maps enables decision makers to
create and view ad hoc reports without requiring the services of the IT staff.

0 SAS Information Delivery Portal provides power analysts and information
consumers with the ability to access reports that were generated by SAS IT
Resource Management and by the business intelligence components of the
SAS Intelligence Platform products. SAS Information Delivery Portal can
also execute stored processes that were created in SAS Enterprise Guide in
order to report on IT data.

Using role-based security, the Web-based interface of the portal can be
customized so that it supplies sensitive content only to authorized users. The
information can be shared among users within an organization and among
external customers, vendors, and partners. In addition, SAS Information
Delivery Portal supports various languages that enable it to accommodate
global and multinational enterprises.

The Middle Tier

The processes and applications on this tier can provide connections between the
client and server tiers, if they are required. In particular, the role of the middle tier is
to provide the functionality that is required for Web-based processing. Middle-tier
applications include both third-party and SAS software elements. They are installed
and configured as components of the SAS Intelligence Platform. SAS IT Resource
Management users do not access these components directly.

The following products are components of the middle tier:

o0 SAS Foundation Services

SAS Foundation Services provide the infrastructure that enables Java
programmers to write distributed applications for the SAS platform. These
services include connecting clients to SAS application servers, managing those
connections, authenticating users, managing sessions and profiles, logging activity,
and accessing metadata and content repositories.

0 SAS Web Infrastructure Kit

This kit contains a set of common Java infrastructure components and SAS
Foundation Services components that can be used to create Web-based applications
(or portlets) that use SAS Information Delivery Portal. Information consumers can
use the components of this kit to customize SAS Information Delivery Portal.

0 Java 2 Software Development Kit, Standard Edition (J2SE SDK)

The Java 2 Software Development Kit provides the software that is required to
perform run-time compilations of the Java servlets that support products such as
SAS Web Report Studio, SAS Information Delivery Portal, and other SAS solutions.
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o Java Servlet Container

The Java servlet container provides the technology to process Java Server Pages
and servlets. Java Server Pages and Java Servlets perform tasks that support
SAS Web applications.

0 SAS Application Services
SAS Application Services provide business-oriented query and reporting
services to the applications that are running on the client tier.
Note: The services required by Web applications can be provided by any of the
following products:
o IBM Websphere (Web infrastructure kit)
o BEA Weblogic (Java Servlet container)
0 Tomcat (Java Servlet container)

A

The Server Tier

The role of the server is to supply data access and the analytical and report
processing that an application requires. Servers can be accessed directly by client
applications or by Web-based applications on the middle tier in order to fulfill requests
from client applications for data and services.

The following servers are required for the data integration and business intelligence
components of the SAS Intelligence Platform:

o SAS Metadata Server

This server provides centralized access to the metadata that is created by and
used by the SAS applications. The SAS Metadata Repository (SMR) is a server
that is accessed by all tiers in order to store, access, and manage enterprise
metadata, including SAS IT Resource Management metadata objects. It manages
the following information:

0 where SAS servers are deployed and how they are configured

O the location of SAS data and how to access it

O the attributes of the data, such as types, formats, and dimensions of the

tables that contain the data

O generic and deployed applications

0 documents, users, processes, and jobs, such as ETL processes

O security issues, such as credentials, user identities, groups, and roles

0o SAS Workspace Server
This server provides access to SAS Foundation features such as the SAS
programming language and SAS libraries.
o SAS OLAP Server
This server provides access to multidimensional data.
o SAS Stored Process Server
This server is used to fulfill client requests for SAS Stored Processes. A SAS

Stored Process is a SAS program that is stored in a central location and can be
executed as needed by other programs.

o SAS/ACCESS
This set of products provides SAS software with direct access to the data in an

external database management system (DBMS). They also make SAS data directly
available to the DBMS.
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o SAS/CONNECT Server

This server provides computing services to a remote client. For example, SAS
Data Integration Studio uses SAS/CONNECT software in order to submit its
generated SAS code to remote computers for processing.

o SAS/SHARE Server

This server controls and executes input and output requests to one or more SAS
libraries. It runs in a separate SAS session.

0 Other SAS Foundation servers (as needed)
0 SAS Adapter for SAP

Note: The SAS Adapter for SAP is optional. It is needed only if SAP data is to
be processed. A

For SAS IT Resource Management, all data resides on the server tier. The data on this
tier includes IT resource data, staged tables and templates, summarized tables, IT data
marts, and all data that is created by and used by SAS IT Resource Management.

Processing IT Resource Data

Introduction to Processing IT Resource Data

SAS IT Resource Management has the technical sophistication and flexibility to
support customers whose usage of the product can range from the basic to the highly
complex. Information consumers can work with specialized tools to access their IT data
directly and generate ad hoc reports. Information consumers can use these reports to
answer specific questions about the health and efficiency of the enterprise’s IT
resources. In all cases, the raw data for the resources that are being evaluated must be
staged and aggregated. The resulting tables are input to the reporting processes.

The following information describes the preliminary tasks that must be performed in
order to use SAS IT Resource Management 3.1.1. It also supplies several scenarios that
show how this solution can be used to manage a site’s IT resources:

O Preliminary Tasks

Before the staging and aggregating processes can run, the data administrator
uses SAS Management Console to perform the following setup tasks:

0 Connect to the metadata server.

o Define new workspace servers.

0 Add users and groups to the online SAS metadata repository (SMR).
The data administrator can ensure the security of the data and the

reports by creating user groups. These groups determine how members of the
groups can access the various components of the system.

0 Modify the default Access Control Template (ACT) for users or groups.

Note: The Access Control Template consists of a list of users and groups
and indicates, for each user or group, whether permissions are granted or
denied. The ACT can be applied to multiple resources. For example, a site
might enable all users of SAS IT Resource Management to perform functions
so that users can define and work with information maps. Enabling all users
to work with information maps is accomplished by granting the user or the
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group permission to read and write metadata and to read and delete data
from the resource that is described by the metadata. 2

0 Define WebDAV content mapping for use by a SAS IT Resource Management
folder.
The HTTP server that WebDAV requires in order to be used by SAS Web
Report Studio and other SAS Business Intelligence Platform applications
must be configured so that its content and its metadata are synchronized and
are compatible with the file structure of SAS IT Resource Management.

For more information about these tasks, see SAS IT Management Solutions:
Administrator’s Guide that is available at this Web site:
http://support.sas.com/itrm.

After this initial setup is completed, SAS IT Resource Management can process
and evaluate IT resource data.

Usage Scenarios

SAS IT Resource Management is a software product that works with data
integration and business intelligence components of the SAS Intelligence Platform.
Its architecture supports many different levels of usage and customer involvement.
The following topics contain only a few of the many scenarios that describe how
SAS IT Resource Management can be used to manage an enterprise’s IT resources:

0 “Creating and Accessing Reports Interactively” on page 19

0 “Generating Customized Reports on the Web” on page 21

0 “Accessing Microsoft Office Products” on page 22

Customers can modify the processes described in these scenarios to suit the
needs of their own enterprises.
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Creating and Accessing Reports Interactively

After the setup tasks have been performed, SAS IT Resource Management can be
run as shown in the following diagram. This processing can be performed without any
customizations. In this scenario, SAS Data Integration Studio is used to define the
transformations that, when executed, will process the data. SAS Enterprise Guide is
used to generate report definitions, which are run interactively. The resulting reports

can be viewed interactively.

Figure 3.2 Creating and Accessing Reports Interactively
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According to this basic scenario, the following processing occurs:

1 For supported adapters, SAS Data Integration Studio with SAS IT Resource
Management plug-ins runs transformations that accomplish the following tasks:

a Stage the raw data.
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The raw data is performance data about IT resources that is generated by
the logging mechanisms that are inherent to IT resources or that is created
by the Enterprise Systems Management tools that are used to manage the IT
infrastructure. The raw data is processed by a supplied adapter that is
specific to the IT data that is being evaluated. The transformations that are
invoked by the adapter extract the raw data, perform any calculations and
conversions that are required by that adapter, and load (stage) the resulting
data into tables in the IT data mart.

Aggregate the staged data.

The staged data is aggregated according to specifications of the supplied
adapter. The data is also manipulated in order to generate any additional
information that is needed for the purposes of IT performance management
and capacity planning. These data manipulations can include calculating
weighted and non-weighted statistics, ranking columns, computing new
columns, and more.

Create basic information maps.

Information maps describe the aggregated data in terms that make sense
to power analysts. SAS Enterprise Guide, SAS Web Report Studio, and other
reporting software use information maps to generate reports.

2 SAS Enterprise Guide generates reports. Analysts can view the resulting reports
interactively in a SAS Enterprise Guide window.
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Generating Customized Reports on the Web

Power analysts can use the business intelligence components of the SAS Intelligence
Platform in order to create information maps that can be used to generate ad hoc
reporting as shown in the following diagram.

Figure 3.3 Generating Ad Hoc Reports
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According to this scenario, the data has already been staged and aggregated so that
power analysts can define and generate customized reports. The following processing
occurs:

1 Power analysts use SAS Information Map Studio to access an aggregated table. By
using this product, they can define information maps that contain the data that
they want to analyze.

2 Power analysts use SAS Web Report Studio to access the information maps that
were created in the previous step. By using this product, they can create report
definitions. After they have specified the contents and the structure of the reports,
power analysts can apply filters to the results in order to provide a more focused
evaluation of the data.
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Accessing Microsoft Office Products

SAS Add-In for Microsoft Office is a business intelligence component of the SAS
Intelligence Platform that enables power analysts to access the reporting and analysis
features of SAS within Microsoft Office Products such as Microsoft Word and Microsoft
Excel. Using the SAS Add-In for Microsoft Office option in Microsoft Word or Microsoft
Excel, power analysts can execute stored processes that were created in SAS Enterprise
Guide as shown in the following diagram.

Figure 3.4 Accessing Data with SAS Add-In for Microsoft Office Products
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According to this scenario, the data is already staged and aggregated and
information maps of the data have been generated. The following processing occurs:
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1 Power analysts use SAS Enterprise Guide to create stored processes that contain
SAS code. When executed, the SAS code performs analytical tasks and generates
reports based on the information maps that were previously generated. The stored
processes can be shared among multiple users.

2 From the Microsoft Word and Microsoft Excel interfaces, power analysts select the
SAS Add-In for Microsoft Office option. They can execute the stored processes that
were created and stored by SAS Enterprise Guide in the previous step.

Note: This same scenario can also be applied to SAS Information Delivery Portal:
Stored processes that are defined in SAS Enterprise Guide can be executed in SAS
Information Delivery Portal. A
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Reference Table of SAS IT Resource Management Tasks

The following table lists the tasks that can be performed with SAS IT Resource

Management and the components that accomplish those tasks.

If you want to perform this task

Use this component:

Create a metadata repository
Define logins for users and groups of users

Create an IT data mart

Delete an IT data mart

Set up staging transformations for the input
data sources

Define ETL processing options

Create batch ETL jobs

Create staged table

Aggregate data tables into summarized
aggregation tables

Aggregate data tables into simple aggregation
tables that are not summarized

Create default information maps

Create customized information maps

Create report definitions

Generate reports and view them interactively
through Microsoft Windows

Generate reports and view them interactively
on the Web

Access SAS functionality from Microsoft Word
and Microsoft Excel

Define stored processes

Execute stored processes

SAS Data Integration Studio
SAS Management Console

New Object Wizard in SAS Data Integration
Studio

Delete IT Data Mart function on the Edit menu of

SAS Data Integration Studio

Adapter Setup Wizard in SAS Data Integration
Studio

Adapter Setup Wizard in SAS Data Integration
Studio

Adapter Setup Wizard in SAS Data Integration
Studio

New Staged Table wizard in SAS Data
Integration Studio

Summarized aggregation transformation in SAS
Data Integration Studio

Simple aggregation transformation in SAS Data
Integration Studio

Adapter Setup Wizard in SAS Data Integration
Studio

Information map transformation in SAS Data
Integration Studio or through SAS Information
Map Studio

SAS Enterprise Guide
SAS Enterprise Guide

SAS Web Report Studio

SAS Add-In for Microsoft Office

SAS Enterprise Guide

SAS ID Portal, SAS Web Report Studio, and SAS
Add-In for Microsoft Office
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What Is the IT Data Mart?

Introduction to the IT Data Mart

The scalability and effectiveness of SAS performance evaluation software depends on
its ability to store and access IT data as well as the processes and jobs that work with
this data. The IT data mart is a key component of SAS IT Resource Management. It is
the logical collection of the jobs, data, information maps, tables, and other elements
that support the extracting, transforming, and loading (ETL) of IT data. IT data marts
are set up, managed, and administered by the data administrator by means of the
wizards and user interfaces that are available in SAS Data Integration Studio. Multiple
data marts can be created in order to help organize a site’s data. For example, a site
might decide to set up a separate data mart for each of its adapters or business areas.

The IT data mart is located in the ITMS Repository, which is established when the
SAS IT Resource Management software is installed.

Note: IT data marts must have unique names. A

IT data marts are located on the Custom tab of SAS Data Integration Studio. To
navigate to an IT data mart from the Custom tab, select Repositories » ITMS »
ITRMSoftwareTree » ITDataMartTree.
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Create an IT Data Mart

You can create an IT data mart by invoking the New Object Wizard that is available
in SAS Data Integration Studio. To create an IT data mart, perform the following steps:

1 From the SAS Data Integration menu bar, select File » New Object to open the
New Object Wizard.
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2 From the list of new objects, locate the IT Resource Management folder. Select 1T
Data Mart and then click Next. The New IT Data Mart Wizard opens.

3 Enter the information that is requested by the New Object Wizard.
Note: If you are creating an IT data mart on a z/OS server, the wizard opens
an additional page on which you can enter information about space allocations. A

4 When you click Finish on the final page of the wizard, the new IT data mart is
created. The wizard generates subfolders in the data mart, which are storage
locations for the jobs, data, libraries, information maps, and tables.

The summary page of the wizard displays the information you entered.

Mew IT Data Mart Wizard

For more information, see the online Help that can be accessed on the pages of
this wizard.

For more detailed information about how to work with an IT data mart, see SAS IT
Management Solutions: Administrator’s Guide that is located at this Web site:
http://support.sas.com/itrm

Contents of the IT Data Mart

The following display shows an IT data mart called “My IT Data Mart.” The folders
in this data mart have been expanded in order to display their contents.
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IT data marts contain the following folders, each of which is tagged with a numeric

identifier that can be used to associate jobs with aggregations, information maps,
libraries, and staged tables:

O Aggregation Tables

This folder contains the metadata definitions for the summarized aggregation
tables and the simple aggregation tables of data. These tables are generated by
the jobs that execute the aggregation transformation.

Information Maps

This folder contains the information maps that are created when an ETL job for
an adapter is executed. Information maps that are created by using SAS
Information Map Studio can also be stored in this folder.

Jobs

This folder contains the ETL jobs that are created for this IT data mart by
wizards or other processes. The jobs can include transformations that execute the
adapter-specific staging code, transformations that aggregate the IT data,
transformations that generate information maps, and more.

The Adapter Setup Wizard creates separate component jobs for each
transformation that it generates. It also creates an overall job that contains all the
component jobs.

The job is visually represented in SAS Data Integration Studio as a Process
Flow Diagram (PFD) with its elements (that is, tables, transformations,
information maps, and so on) displayed in a data processing flow.

Libraries

This folder contains the library definitions for the administration and spin
libraries as well as the definitions for the staged tables, and the simple and
summarized aggregation tables, if they have been created.

0 Admin Library

This library contains metadata about the tables and files that are
created and used by the data validation processes in SAS IT Resource

Management. The metadata is used to prevent the addition of duplicate data
to the IT data mart tables.
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Note: This table resides in the IT data mart library but it is hidden and
not accessible by the user. A

O Spin Library

The spin library contains the metadata about spin tables. Spin tables
contain incomplete data about an event that is being measured. For example,
an ETL job might process a record that reflects the beginning of an event.
The record that reflects the end of that event might not be received until a
future ETL job. In order to process the information about the entire event,
the incomplete data must be stored in a separate location (the spin table)
until the record that completes it is available. The incomplete record is stored
until its matching record arrives in this ETL or a future ETL, or until the
beginning record ages out. When the matching record arrives, the complete
data about the event is moved to a summarized or simple aggregation table,
as specified by the aggregation transformation.

Note: Spin tables are used for data from MXG-based adapters only. A

O Other Tables

This folder contains the metadata definitions for the tables of data that the user
might need. These tables can include reference tables. These lookup tables supply
site-specific information such as the name of business units and their descriptions.
The tables are created by the data administrator.

O Staged Tables

This folder contains the metadata definitions for the staged tables of data. A
staged table is a table that contains data that has been extracted from an input
data source and then rendered in a form that is suitable for further transformation.

These tables are generated by the jobs that execute the staging transformation
that is run for each supplied adapter. The IT performance records for each adapter
have unique characteristics that must be specified before executing the ETL job for
that adapter. The Adapter Setup Wizard specifies these staging parameters and
stores the resulting staged tables in the IT data mart.

Users can also generate staged tables by using the New Staged Table wizard to
define the table and then by creating and executing a job that stages the raw data.

For more information about the New Object Wizard, see the online Help or the SAS
IT Management Solutions: Administrator’s Guide that is located at this Web site:
http://support.sas.com/itrm.
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What Are Adapters?

Adapters are key components of SAS IT Resource Management. Adapters consist of
specialized software that enables the customer to load raw data about IT resources from
many diverse data sources. Adapters also enable the customer to convert that raw data
into a standard form that facilitates aggregation and reporting about their IT resources.
Raw performance data is generated by the logging mechanisms that are inherent to IT
resources. It can also be created by the Enterprise Systems Management tools that are
used to manage the IT infrastructure. SAS IT Resource Management accepts data from
many different vendors—the only requirement is that the data must include a
timestamp so that it can be categorized and aggregated appropriately for subsequent
analysis.

Raw data about an IT resource is represented using measures and formats that are
specific to the software that collected it. In order for the data to be processed into
statistics about an enterprises’s IT resources, the raw data must be read, interpreted,
and possibly converted into a more standard form. It can then be loaded into staged
tables in preparation for subsequent aggregation and reporting.

For each type of IT performance data that it supports, SAS IT Resource Management
supplies an adapter that consists of the template tables, transformations, and staging
code that are necessary to stage that IT performance data.

For many adapters, SAS IT Resource Management also supplies information map
transformations and aggregation transformations by means of the Adapter Setup
Wizard. If not supplied, these transformations can be created manually. To do so, see
the Help topics “Create an Information Map Transformation” and “Create an
Aggregation Transformation.”
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The supplied adapters can be viewed from the custom tab of SAS IT Data
Integration Studio.

Display 5.1 View of Supplied Adapters in Custom Tab
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Note: In the preceding display, the AdapterTree folder is expanded to show the
supplied adapters. In addition, the Device and Network folders in the Patrol adapter
are expanded to show their template tables. 2

Adapters stage the data by means of transformations that are executed by the SAS
Data Integration Studio jobs. For information about how to work with SAS Data
Integration Studio, see SAS Data Integration Studio: User’s Guide that is available on
this Web site:

http://support.sas.com/documentation/onlinedoc/etls/index.html.

Types of Adapters

The name of an adapter represents the data source from which SAS IT Resource
Management gathers raw data. The following table shows the adapters that are
supported by SAS IT Resource Management that are available to access raw data files
for specific operating environments.

Tahle 5.1 Table of Supported Adapters

Adapter Name Description

User-written

User-written Staging Code User-written staging code is supported by the Source Designer
and Target Designer of SAS Data Integration Studio and
transformations that are supplied by SAS IT Resource
Management.

For z/OS Data Sources (and for raw data sources that are supported through MXG)
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Adapter Name

Description

DCOLLECT

EREP

IMF

NTSMF-MXG

DASD Collect obtains the following Mainframe Storage System
data:

active data sets
VSAM data set information

volumes

migrated data sets

O

O

O

O inactive data
O

O backed-up data sets
O

capacity-planning data such as the following:

O DASD capacity planning: DCOLLECT provides
information and statistics for volumes that are managed
by DFSMShsm (MLO and ML1).

O tape capacity planning: DCOLLECT provides statistics
for tapes that are managed by DFSMShsm.

O SMS configuration information

Environmental Record Editing and Printing processes the error
records from the MVS, VM, and VSE operating systems to produce
formatted reports. These EREP reports can show the status of
the entire installation, an I/O subsystem, or an individual device,
depending upon which report you request. EREP reports can vary
in format, depending on the following report types:

O System summary reports show error data in summary form.
O Trend reports show error data by daily totals.

O Event history reports show error data in a time sequence by
occurrence.

The BMC Mainview for IMS product, formerly the Boole &
Babbage Control/IMS, supplies transaction information such as
CPU usage, number of I/0Os, and response time. When you collect
IMF data instead of IMS Monitor data, BMC recommends that
you collect a duration of one hour of consistently high activity,
starting at the beginning and ending at the end of an RMF
interval.

The Demand Technology NT System Management Facility is the
system management facility for Windows NT, Windows 2000,
Windows XP, and Windows 2003 servers and workstations.
NTSMF collects data from Windows systems and for Windows
server applications such as Exchange, SQL Server, and IIS.

Note: SAS IT Resource Management also supports a
separate NTSMF adapter that is not z/OS based. A
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Adapter Name

Description

SMF

TMON2CIC

TMONDB2

T™S

The IBM System Management Facility collects and records
system and job-related information that is used for the following
purposes:

O billing users

reporting reliability

analyzing the configuration

scheduling jobs

summarizing direct access to volume activity
evaluating data set activity

profiling system resource use

O oo oo o g

maintaining system security

Note: RMF is a subtype of SMF records. RMF is the
IBM strategic product for z/OS performance
measurement and management. RMF is the base
product that collects performance data for z/OS and
Sysplex environments to monitor system performance.
Because RMF data is a subtype of SMF data, no further
adapter work is necessary. A

ASG-TMON for CICS TS for z/OS, formerly Landmark TMON,
monitors the CICS Transaction Server (TS) and provides resource
consumption measurements by tracing each transaction’s
performance by CICS event and related unit of work.

Note: CICS data can be produced by either
TMONCICS or as a subtype of SMF. A

ASG-TMON for DB2 monitor, formerly Landmark TMON, works
with the SQL Analyzer to manage DB2 applications and critical
DB2 resources by providing a single view of DB2 data-sharing
group performance. TMON for DB2 tracks DB2 buffer pools, lock
contention and serialized resource usage, transaction statistics
from ASG-TMON for CICS to TMON for DB2, and dynamic and
static SQL calls. TMON for DB2 provides a view for all
performance statistics by plan, package, and statement, including
CPU time, I/O analysis, lock activity, and buffer pool utilization
by SQL statement.

The Computer Associates Tape Management System product
controls and protects tape data sets and volumes in z/OS
environments.

TPF

The IBM Transaction Processing Facility operating system works
with application programs to process transactions in a real-time
environment. The TPF system is designed for businesses and
organizations that have large networks and high volumes of
online transactions.

VMMON

IBM VM Monitor collects performance information that is
associated with VM, including measurements for user activity,
processor storage, I/0, and applications.

For Distributed Systems Data Sources
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Adapter Name

Description

HP-OVPA

HP-OVREP

HP Performance Manager Agent software, formerly OpenView
Performance Agent, captures enterprise systems management
measurement data for IT resources from Windows systems and
many UNIX variants such as HP-UX, Sun OS/Solaris, IBM AIX,
Tru 64 UNIX, and Linux.

HP Reporter software, formerly OpenView Reporter, captures HP
OpenView measurement data that is stored in a relational
database via SAS/ACCESS to Oracle or ODBC.

Patrol

BMC Performance Manager for Servers, formerly BMC Patrol,
collects UNIX and Windows enterprise system management data
from UNIX and Windows systems.

For Windows Systems Data Sources

NTSMF

The Demand Technology NT System Management Facility collects
Windows Systems Management Facility data for servers or
Exchange. NTSMF is the system management facility built for
Windows NT, Windows 2000, Windows XP, and Windows 2003
servers and workstations. NTSMF collects data from Windows
systems and for Windows server applications such as Exchange,
SQL Server, and IIS.

Note: SAS IT Resource Management also supports a
separate NTSMF adapter that is z/OS based. The
NTSMF adapter that is z/OS based is for raw data
sources that are supported through MXG. A

For UNIX Systems Data Sources

SAR

System Activity Reporter is a logging mechanism that is native to
most UNIX and Linux variants. SAR captures the contents of
cumulative system activity counters.

For Applications Data Sources

SAPR3

SAP R/3, via the SAS IT Management Adapter for SAP, collects
SAP R/3 and SAP Business Warehouse (BW) workload
performance measurements.

O For SAP R/3, measurements are read from the SAP
Statistic File (stat file).

O For SAP BW, the measurements that communicate the
amount of computer resources that were consumed to
populate and query BW cubes are read. These
measurements are then used to supplement BW server
performance statistics.

For AS/400 and IMS systems, customers can process the data from these sources by
creating the staged and aggregated tables that are necessary to generate IT
performance reports and by creating the jobs that will execute the transformations that
generate the data for those tables. The Source Designer functionality of SAS Data
Integration Studio can create the transformations that stage raw data from any input
source. SAS Data Integration Studio provides the following functionality:

0 The Source Designer is the tool that is used to specify information about the raw

data input source, such as the following:
O the type and location of the source of raw data
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the name and file access method of the data server

the record length, starting record location, and number of records to process
the character that delimits the fields of data in the record

how to define and name the columns of data

instructions about how to apply formats and informats to the data

O 0o o o o o

the name of the IT data mart to be used to store the input file

0 The staging transformation and the aggregation transformation are the tools that
are used to specify information about the staged table or aggregation table, such
as the following:

O the type of table to be created

the name of the table that is to be created

the type of storage and the library that is to contain the target data set
the folder that is to contain the table

the name of the raw data that is to be input to this transformation

the columns of the raw data that are to be input to this transformation
the location of the metadata for that data set

O O oo o o

For information about user-written staging code, see SAS IT Management Solutions:
Administrator’s Guide that is located here: http://support.sas.com/itrm.

Staging the Data

Introduction to Staging the Data

A staging transformation generates a SAS program that loads the raw data into the
staged tables. When this program is executed by a job in SAS Data Integration Studio,
it dynamically accesses the metadata for the staged tables and the parameters that are
specified in the staging transformation. The SAS program uses this information to
populate the staged tables. A unique staging transformation is associated with each
supported adapter.

Note: All SAS IT Resource Management adapters are supported for all SAS IT
Resource Management operating environments unless there is a technical limitation
that is associated with the raw data (log file) data sources. For example, if the raw data
resides on a device that is not compatible with the architecture of the SAS IT Resource
Management server, then that raw data file might not be usable as input unless further
processing is performed. A

Every time a staging transformation is executed, the existing data in the staged table
is removed in order for the new data to be loaded. The staged table is generally used as
input to an aggregation transformation. However, a user can change this process flow
by using the standard methods that are available in SAS Data Integration Studio. In
addition, a staging transformation can be modified to include additional staged tables
that are supported by the given adapter transformation. This feature enables the
system to process data from various sources through the same staging transformations
and aggregations. (For information about aggregations, see Chapter 6, “Aggregations,”
on page 39.)
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Before loading the performance data into staging tables, adapters perform any
additional processing that is necessary to convert the data into standardized,
normalized values. The measures and formats that are used to collect the various types
of performance data determine any special processing that the adapter must perform.

Depending on the adapter, the staging transformation might also perform other
functions, such as:

0 detecting and handling duplicate data
generating computed columns from the input data
enabling or disabling processing features at run time

supporting the input of single files

O 0o o g

on Windows and UNIX, supporting the transfer of data from z/OS by means of the
File Transfer Protocol (FTP)

o for MXG-based adapters, providing support for spin files

SAS IT Resource Management provides two methods of staging IT performance data:
O by using the Adapter Setup Wizard

0 by using the New Object Wizard

Using the Adapter Setup Wizard

The Adapter Setup Wizard guides you through the steps that set up the jobs that,
when run, execute the staging transformations, the information map transformations,
and the aggregation transformations for a supported input data source. These steps
include entering the name of the IT data mart where the staged tables will reside, the
name of the adapter, the location of the raw data, and possibly some parameters that
specify how the data is delimited or how duplicate data checking is to be performed.
The Adapter Setup Wizard creates the required staged tables by using the template
tables that are supplied for each adapter.

To invoke the wizard, on the Shortcuts Bar of the SAS Data Integration Studio
desktop, click Adapter Setup.

Note: The shortcuts Bar is an optional pane of task icons on the left side of the
SAS Data Integration Studio desktop. To display it, select View » Shortcuts Bar from
the menu bar. For more information about this topic, see the online Help for SAS Data
Integration Studio. A

Using the New Object Wizard

You can also set up a staging transformation by using the New Object Wizard. Like
the Adapter Setup Wizard, the New Object Wizard for Staged Tables guides you
through the steps that are necessary to define the staged tables. These steps include
entering the name of the IT data mart where the staged tables will reside, the name of
the adapter, the location of the raw data, and possibly some parameters that specify
how the data is delimited or how duplicate data checking is to be performed. However,
unlike the Adapter Setup Wizard, the New Object Wizard enables you to select the
template tables that you want to use. You do not have to use all the tables that are
supplied for this adapter.

To invoke the wizard, perform the following steps:

1 Navigate to ITDataMartTree. To do so, click to expand the following objects:
Repositories » ITMS » ITRMSoftwareTree » ITDataMartTree.

2 Select the IT data mart where you want to store your staged tables.
3 Right-click staged Tables. From the drop-down menu, select New Object.
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4 Enter the information that is requested by the New Object Wizard.

5 When you click Finish on the final page of the wizard, the metadata for the new
staged table is created. The table does not have data in it until a transformation
that loads the data is executed.

The summary page of the wizard displays the information you entered.

Mew Staged T able

Note: You can also invoke the wizard in the following way: From the menu
bar, select File » New Object. Then, in the IT Resource Management folder,
select staged Table. A

For more information about this wizard, see the online Help that can be accessed on
the pages of this wizard. You can also find information about this topic in SAS IT
Management Solutions: Administrator’s Guide that is located here:
http://support.sas.com/itrm.
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What Are Aggregations?

An aggregation is a type of transformation that specifies how data is to be
transformed and stored so that it can provide the needed report-ready IT performance
data. In particular, an aggregation provides specifications for the following functions:

O

O
O
O
O

identifying the location of the input data
filtering data

populating computed columns
calculating statistics

performing rolling accumulations based on any time period (for example, daily,
weekly, monthly, quarterly, and yearly time periods)

ranking of individual class variables over all the data, as well as ranking of
statistics across requested subgroups of the class list

grouping (classifying) the data according to user specifications

Generating Aggregation Tables

Aggregation tables are generated in two ways:

O

Using the Adapter Setup Wizard: This wizard starts with identifying the raw data
that is input and then guides the customer through a series of questions in order
to create the following entities that are associated with that adapter:

o libraries

staging transformation

staged tables that are associated with that staging transformation
aggregation transformations that aggregate the staged tables
summarized and simple aggregation tables

O 0o o o o

information map transformations that are associated with the aggregation
tables

Note: The Adapter Setup Wizard does not support all supplied SAS IT
Resource Management Staging Transformations. A
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0 Defining a simple or summarized aggregation: A simple or summarized

aggregation can be defined, edited, or deleted from the Properties window of an
aggregation transformation within a job.

The job can contain multiple aggregations each of which produces a single
aggregated table. (In many instances, adapters require multiple aggregations in
order to provide the data that is needed for the reporting processes.) The job that
runs the aggregation transformation can be executed either by SAS Data
Integration Studio interactively or in batch mode.

By selecting the Aggregations tab of the aggregation transformation, the
customer can invoke the Summarized Aggregation Wizard or the Simple
Aggregation Wizard. The aggregation wizard requires the specification of the
physical table that is input to the aggregation. (The input to the aggregation is
usually a staged table.) The wizard then guides the customer through a series of
questions in order to generate the aggregations that process the input tables and
the aggregation tables that are generated by each aggregation within the job.

When you click Finish on the final page of the wizard, the new aggregation is
created and the corresponding summary page is displayed, as follows:

0 If you created a summarized aggregation, the summary page of the
Summarized Aggregation Wizard displays the information that you entered.

Display 6.1 Summary Page of the Summarized Aggregation Wizard

Summarnzed Aggregation Wizard : SASMain
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o If you created a simple aggregation, the summary page of the Simple
Aggregation Wizard displays the information that you entered.

Display 6.2 Summary Page of the Simple Aggregation Wizard

Simple Aggregation Wizard : SASMain

Note: For information about how to invoke the Summarized or Simple Aggregation
Wizards, see the Help topic called “Create an Aggregation Transformation.” »

Aggregation Example

In this example, the raw data that is processed by the NTSMF staging
transformation is loaded into staged tables, called NSERVER and NCACHE tables.
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Display 6.3 Example of an Aggregation Transformation
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These staged tables are, in turn, input to aggregations that perform the following

tasks:

0 The upper aggregation processes the NCACHE staged table and generates one
summarized aggregation table called Cache Table.

0 The lower aggregation processes the NSERVER staged table and generates two
aggregation tables called the Server Table and the Daily Server Table. Icons next
to these tables in the Custom tab are visual reminders of whether the aggregations
are summarized or simple. The Server Table is a summarized aggregation table
and the Daily Server Table is a simple aggregation table.

In this example, an information map transformation is generated from the
Daily Server Table.

The following example shows what the custom tab displays for this job and its tables.
Display 6.4 Custom View of an NTSMF Job and Its Tables
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For more information about working with aggregations, see SAS IT Management
Solutions: Administrator’s Guide that is located at this Web site:
http://support.sas.com/itrm. For information about SAS Data Integration Studio,
see SAS Data Integration Studio: User’s Guide that is located at this Web site:
http://support.sas.com/documentation/onlinedoc/etls/index.html.
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Introduction: The Reporting Process

The purpose of SAS IT Resource Management is to manipulate raw IT performance
data so that the user has access to report-ready information about the enterprise’s IT
resources. SAS IT Resource Management provides a unique adapter for each data
source that it supports. The support for each adapter includes staging and, in most
cases, aggregation transformations that are appropriate for the type of data that the
adapter handles. When these transformations are run, they generate tables of data,
statistics, and rankings that are accumulated according to the specifications that were
defined by the transformation that was either generated by the Adapter Setup Wizard
or created by the user. In addition, the information map transformation generates
information maps that describe each table and its contents in terms that are
meaningful to business people.

Summarized and simple aggregation tables and the information maps that refer to
them are the primary inputs to the reporting process. These tables and maps are
registered in the SAS Metadata Server. After you have connected to the appropriate
metadata server, you can access these tables and maps by using tools that are available
with the SAS Intelligence Platform. Among these business intelligence components are
the following products that provide methods for generating and viewing reports:

0 SAS Enterprise Guide

o SAS Web Report Studio

0 SAS Add-In for Microsoft Office
0 SAS Information Delivery Portal

SAS Enterprise Guide
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Overview of SAS Enterprise Guide

SAS Enterprise Guide is the primary report-generating product that SAS provides. It
communicates with the SAS System to access data, perform analysis, and generate
results. Regardless of their SAS knowledge, users can produce results easily and
quickly. SAS Enterprise Guide provides the following features:

O an intuitive, visual interface

O transparent access to data

O ready-to-use tasks for analysis and reporting
O a code editing facility

SAS Enterprise Guide can connect to various SAS Metadata Repository operating
environments, including UNIX, z/OS, and Windows.

SAS Enterprise Guide uses projects to manage a collection of related data, tasks,
code, and results. With projects, you can run multiple tasks on the same group of data
files and create interactive reports. These tasks enable you to analyze and report on the
aggregation data and information maps that are generated in SAS IT Resource
Management. Aggregation tables and information maps can be input to a number of
different analytic tasks in SAS Enterprise Guide in order to create report definitions.
Using functions that are available in SAS Enterprise Guide, you can generate a wide
variety of analytic reports for resource management purposes (for example, utilization
of resources, performance of IT devices, and forecasting for capacity planning). The
resulting report output can then be viewed interactively in SAS Enterprise Guide or
published to the Web.

SAS Enterprise Guide can generate report output about your IT resources by directly
accessing the summarized and simple aggregation tables of data that are generated by
IT Resource Management or by using information maps that refer to that data in order
to import the appropriate tables of data into the project. (SAS IT Resource
Management supplies information maps for many adapters that it supports.)

Create a Report in SAS Enterprise Guide

To create a report in SAS Enterprise Guide, perform the following steps:

1 Start SAS Enterprise Guide from the Windows Start menu by selecting Programs
» SAS » SAS Enterprise Guide.
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Display 7.1 SAS Enterprise Guide Welcome Window
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2 From the Welcome window of SAS Enterprise Guide, you can select an existing
Project Designer window that you have already opened or you can create a new
project. (If you want to work with a new project that has not been opened before,
click x to close the Welcome window and select the File menu. From the list of
tasks that displays, you can open an existing project or you can create a new
project.)

Note: If Don’t show this window again is checked, the Welcome window is
not opened. In that case, use the File menu to open a new or existing project. A

3 The preferred method of reporting is to use information maps. (Information maps
enable you to select only the data items and filters that you want to work with.)
To report using information maps, perform the following steps:

a Select File » Open » Information Map.
b Select the information map that you want to use.

(You can also add an information map to a project by using the SAS
Folders window. To open this window, select View SAS Folders.
Double-click on the information map that you want to add to the project.)

¢ Select the data items and optional filters that you want to include in your
table. In addition, you can select an output location for the table that will be
generated.

d Click ok to run the information map that creates the table.

4 If you want to work directly with your tables of data, perform the following steps:

a Select File » Open » Data.

b Select the SAS server that contains the table that you want to use.

¢ Select the library that contains the data that you want to report on. (Refer to
the Jobs folder of your IT data mart in SAS Data Integration Studio to
determine the name of the library that is associated with the table you are
working with.)
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d Then, select the appropriate summarized or simple aggregation table from
the list that is displayed and open it.

5 Add a report task to the project.

6 The SAS data set that is created can be used as input for further tasks and
queries. To create a stored process, right-click on the report task and select
Create Stored Process to invoke the Create New SAS Stored Process Wizard.
(A stored process is a SAS program that can be stored on a central server and
accessed by multiple remote clients. Along with the advantages of shared, secure
code, stored processes enable users to take advantage of the SAS Enterprise Guide
drag-and-drop interface to build and share complex SAS programs.)

Note: You can execute the SAS code that you generated interactively in SAS
Enterprise Guide. Alternatively, you can run a SAS Enterprise Guide project in
batch mode outside the SAS Enterprise Guide application by saving the project
and using a script program to run the project and direct the output to your Web
browser. For more information about running jobs, see the SAS IT Management
Solutions: Administrator’s Guide. A

For more information about SAS Enterprise Guide, see the SAS Enterprise Guide
Help and the SAS Enterprise Guide Tutorial, which are available from within the
product. You can also refer to the documentation at this Web site:
http://support.sas.com/documentation/onlinedoc/guide.

SAS Web Report Studio

Overview of SAS Web Report Studio

SAS Web Report Studio is a Web-based query and reporting application that is
provided by the business intelligence components of the SAS Intelligence Platform. It is
designed for users who want to generate reports, view them, and share them with
others on the Web.

SAS Web Report Studio uses data sources to create report definitions. Data sources
are information maps that translate technical data structures into user-friendly
business terminology. The maps provide access to data items in the summarized and
simple aggregation tables of data that are generated by the aggregations in SAS IT
Resource Management. Information maps are created when the information map
transformations that are supplied with SAS IT Resource Management are run.
(Information maps can also be created manually. See the Help topic called “Create an
Information Map Transformation.”)

Note: SAS Information Map Studio can be used to modify the maps that are
generated by Information Map transformations in SAS Resource Management.
However, the information maps that are automatically generated at ETL time by the
Information Map transformations are recreated whenever the ETL job is run.
Therefore, any modifications that were made to an information map before running the
ETL job will be lost. To avoid this situation, modify a copied version of the
automatically generated information map and save that modified version under a
different name so that it will not be overwritten by the ETL processes. 2
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Create a Report in SAS Web Report Studio

To create a report by using SAS Web Report Studio with an information map as the
data source, perform the following steps:

1 From the SAS Intelligence Platform, access SAS Web Report Studio. From the
Welcome to Web Report Studio window, click Report to create a new report
definition.

Display 7.2 Welcome Window of SAS Web Report Studio
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2 Using the appropriate information map as the data source, specify (or modify) a
report definition. SAS Web Report Studio provides several tools for this purpose,
such as the Edit Report view and the Report Wizard. Templates are also available
from which to design a report.

3 Generate the report by executing the report definition in Web Report Studio. The
information map will access the corresponding data items that are in the tables of
summarized and simple aggregation data that you included in your report
definition.

4 View the generated report in your Web browser.

The following example shows the Edit Report tab for an Hourly CPU Utilization
report:
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Display 7.3 Sample Report for Hourly CPU Utilization
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For more information about using SAS Web Report Studio, see the SAS Web Report
Studio Help, which is available from within the product. For information about
administrative tasks associated with SAS Web Report Studio, see the “SAS Intelligence
Platform: Web Application Administration Guide.” To locate this information, perform
the following steps:

1 From the Web site at
http://support.sas.com/documentation/onlinedoc/sas9doc.html, select
Documentation for the SAS 9.1.3 in PDF.

2 From the drop-down list of products at the top of the page, select sas
Intelligence Platform and click Go.

3 Scroll down the list of documentation, and select “SAS Intelligence Platform: Web
Application Administration Guide.”

SAS Add-In for Microsoft Office

SAS Add-In for Microsoft Office is a SAS Intelligence Platform tool that provides
access to SAS from the menus and toolbars of Microsoft Office products. From Microsoft
Word and Microsoft Excel, information consumers and power analysts can use SAS to
access data, perform data analysis, and prepare reports. In the following example, the
Analyze Data window displays the graphs and charts that can be used to analyze data:
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Display 7.4 Accessing the Analyze Data Window from SAS Add-In for Microsoft Office

 Table 545 Window Help Tupe & questionforhelp = X

B Analyze Data

B[S 545 Tasks o
{25 Addin Examples B8 Area Plat Task Generate aArea Plot for a set of data
(53 ANDvA ial Bar Chart Task Generate a Bar Chart for a st of data,

201 Capabilty i Bar Chat Wwizard Wizand Generate a Bar Char for a set of data,

% ool s 1 BarLine Chart Task Genests & Bar-Line Chat for 3 set of dts
{3l Descibe [ B Piot Task Generate a Box Plot far & set of data.

& [%* Bubble Plot Task Generate a Bubble Plot for a set of data
1 ITAM Addns B3 Contour Plot Task Generate a Contour Plot for 2 set of data
[E5 Model Scoring Eﬁ'tleate Map Feature Table Task Lreate a feature table for a map data set
B Multivariale &5 Donut Chart Task Generate a Donut Chart for a set of data
[ Pareto [+ Line Plot Task Gererats a Line Plot for a set of data
(25 Regression lﬁﬁ Lire Plot wizard “fizard Generate a Line Plot for a set of data
{E3 545 Custom Task # Map Graph Task Generate a Map Graph for a set of data
{E5 Survival Analysis @ Pie Chart Task Generate a Pie Chart for a sat of data
{E3 TileChart Category € Pie Chart \wizard “izard Generate a Pie Chart for a set of data
{5l Time Geries A Riadar Chart Task Generate a Radar Char for 3 set of dala
i Seatter Plot Task Generate a Soatter Plot for 3 set of data
hrSurlace Plat Task Generate a Suface Plot for 2 set of data

AR it Gl REC TRKERT OWR [

In addition, SAS Add-In for Microsoft Office enables information consumers and
power analysts to run stored processes and to customize the appearance of results that
are returned by Microsoft Word or Microsoft Excel. The following example shows a
stored process for creating a CPU Utilization report:

Display 7.5 Stored Process for CPU Utilization
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SAS Information Delivery Portal

SAS Information Delivery Portal is a business intelligence component of the SAS
Intelligence Platform. It provides a Web-based interface that can be used to view and
organize SAS IT Resource Management content, including SAS Information Maps, SAS
Stored Processes, SAS publication channels and packages, SAS reports, documents,
syndication channels, and links to Web addresses. Users can run stored processes,
which were created in SAS Enterprise Guide. These stored processes generate reports
using the tables of IT Resource Management data. SAS Information Delivery Portal
also provides single sign-on so that users can launch applications such as SAS Web
Report Studio from the portal without reentering a user name and password. The
reports that are generated by SAS Web Report Studio can be displayed and distributed
to other users from this portal. The SAS Information Delivery Portal can provide
security so that reports can be viewed only by a particular group of users.

In the SAS Information Delivery Portal, pages are the primary means of organizing
information. The following example shows a page called Home:

Display 7.6 SAS Information Delivery Portal
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The Home page in the preceding example was set up to enable you to log on to SAS
Web Report Studio and to link to favorite reports and stored processes.

For more information about using the SAS Information Delivery Portal, see the Help
that is available from within the product. For information about administrative tasks
that are associated with SAS Information Delivery Portal, see the SAS Web
Infrastructure Kit: Developer’s Guide. This documentation is located at this Web site:
http://support.sas.com/rnd/itech/library/library9.html.
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Other Resources

SAS IT Resource Management provides many other resources to assist you in using
this product and in managing your IT resources. The resources that SAS IT Resource
Management provides include the following:

O

O
O
O
O

online documentation

Web-based documentation

technical support

training and consulting services

SAS IT Resource Management e-mail forum

Each of these resources is described in the following sections of this appendix.

The user interface for SAS IT Resource Management is available through the
following SAS product interfaces:

O

SAS Data Integration Studio

Online Help consists of the standard help for SAS Data Integration Studio and
the help for the additional software that provides support for SAS IT Resource
Management. To access this help from within SAS Data Integration Studio, click
Help on the associated window or press the F1 key.

SAS Management Console

Online Help consists of the standard help for SAS Management Console. To
access this help from within SAS Management Console, click Help on the
associated window or press the F1 key.
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0 SAS Enterprise Guide
Online Help consists of the standard help for SAS Enterprise Guide. To access
this help from within SAS Enterprise Guide, click Help on the associated window
or press the F1 key.
o SAS Web Report Studio
Online Help consists of the standard help for SAS Web Report Studio. To access
this help from within SAS Web Report Studio, click Help on the associated window
or press the F1 key.
0 SAS Information Map Studio
Online Help consists of the standard help for SAS Information Map Studio. To
access this help from within SAS Information Map Studio, click Help on the
associated window or press the F1 key.
o SAS Add-In for Microsoft Office
Online Help consists of the standard help for SAS Add-In for Microsoft Office.
To access this help, on the toolbar for Microsoft Word or for Microsoft Excel, select
sAs. Then, select SAS Add-In for Microsoft Office.
o SAS/CONNECT

Online Help consists of the standard help for SAS/CONNECT. To access this
help from within SAS, click Help to open SAS Help and Documentation. From the
SAS Products section, scroll down to the help for SAS/CONNECT.

o SAS/SHARE

Online Help consists of the standard help for SAS/SHARE. To access this help
from within SAS, click Help to open SAS Help and Documentation. From the SAS
Products section, scroll down to the help for SAS/SHARE.

Webh-Based Product Documentation

Ahout Weh-Based Product Documentation

SAS IT Resource Management is built on the SAS®9 architecture and leverages other
SAS products and solutions. Web-based access to SAS product documentation is
available for the following:

0 SAS IT Resource Management documentation
0 SAS System documentation

To access these Web pages, use a frame-capable version of a Web browser such as
Microsoft Internet Explorer or Netscape Navigator.

SAS IT Resource Management Documentation

Information about SAS IT Resource Management 3.1.1 is available from the Web
page at: http://support.sas.com/itrm. Along with notes about topics of general
interest, this site contains links to the following sets of documents:

0 Introduction to SAS IT Resource Management: Provides an overview of SAS IT
Resource Management 3.1.1.

0 SAS IT Management Solutions: Administrator’s Guide: Provides a detailed
description of the SAS IT Resource Management 3.1.1 for data administrators.
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O Installation documentation is available from the Install Center, which can be found
at this location: http://support.sas.com/documentation/installcenter/
index.html. It describes how to install and configure the latest software.

0 SAS IT Resource Management: Migration Documentation: Describes how to
convert your IT Resource Management 2.7 environment to SAS IT Resource
Management 3.1.1.

Note: Information about the previous versions of the software, SAS IT Resource
Management 2.7, is available from the Web page at:
http://support.sas.com/itrm. A

Technical Papers, presentations, white papers, and SAS Global Forum papers provide
information about many topics, including those papers that pertain to managing your
IT resources. This information is located at this Web site:
http://support.sas.com/documentation/whitepaper/technical/.

SAS System Documentation

The SAS System includes many software products and solutions that are leveraged
by SAS IT Resource Management. You can access SAS documentation from this Web
page: http://support.sas.com/documentation/onlinedoc. You can view
documentation for SAS®9, SAS 8, and also documentation for the other products and
solutions that are used by SAS IT Resource Management. To view this documentation,
select a product from the drop-down list and click Go.

Note: You can also order SAS books from SAS Book Sales (1-800-727-3228). A

Technical Support

If you have questions or problems about your licensed software, you might want to
explore the SAS Institute Technical Support Web site at http://support.sas.com/
techsup/intro.html.

The Technical Support Web site offers SAS Notes, Technical Support documents,
FAQs, SAS sample programs, phone numbers, and e-mail support. This Web site also
provides an online mechanism for reporting and tracking problems and questions for
Technical Support. These electronic services are available 24 hours a day.

If you want your question or problem handled by phone, ask your site’s SAS
Installation Representative or on-site SAS support personnel to call the SAS Technical
Support Division. Sites in North America can call 919-677-8008 or send a Fax to
919-531-9449. Sites that are outside of North America should check the Technical
Support Web site or contact their SAS Installation Representative or on-site SAS
support personnel for the nearest SAS Institute office.

Training and Consulting Services

The SAS IT Resource Management solution is tightly integrated with other SAS
solutions, such as SAS Data Integration Studio, SAS Enterprise Guide, and the
business intelligence components of SAS Intelligence Platform. Therefore, customers
might require training for these solutions as well for SAS IT Resource Management.
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SAS offers training that is suited to your needs. For example, you can select live Web
classes, instructor-led classes, or self-paced SAS e-Learning courses. Because SAS is a
global company with customers in many different countries, SAS also provides training
in the national language of many of these countries. For more information, see the
Training Web page at the following address: http://support.sas.com/training/
index.html. At this Web site, you can select training that is appropriate for your
location and language.

You can also contact the SAS Education department by calling 1-800-333-7660.

SAS IT Resource Management E-mail Forum

You can exchange information with other users of SAS IT Resource Management by
subscribing to the ITMS-L listserv. This e-mail forum is available for users to exchange
tips, techniques, and information about SAS IT Resource Management.

o0 To subscribe, send an e-mail message to listserv@um.sas.com with the following
information:

1 Leave the subject line blank.
2 In the body of the message, type

subscribe ITMS-L <your first name> <your last name>

For example, type the following: subscribe ITMS-L John Smith

0 To remove your name from the e-mail forum, send an e-mail message to
listserv@um.sas.com with the following information:

1 Leave the subject line blank.
2 In the body of the message, type

signoff ITMS-L

O To send mail to the listserv, send e-mail to itms-I@um.sas.com.
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Statistics

SAS IT Resource Management can calculate the following statistics:

O
O
O
O
O
O
O
O
O
O

count

geometric mean

harmonic mean

harmonic mean weighted by (user-specified numeric column from the input table)
maximum

mean

minimum

number missing

population coefficient of variance

population coefficient of variance weighted by (user-specified numeric column from
one of the input tables)

O population standard deviation

0 population standard deviation weighted by (user-specified numeric column from

the input table)

O population variance

population variance weighted by (user-specified numeric column from the input
table)

O range

o sample coefficient of variance

0 sample coefficient of variance weighted by (user-specified numeric column from the

input table)

0 sample standard deviation

0 sample standard deviation weighted by (user-specified numeric column from the

O o o o o

input table)

sample variance

sample variance weighted by (user-specified numeric column from the input table)
sum

uncorrected sum of squares

weighted geometric mean weighted by (user-specified numeric column from the
input table)

o weighted mean weighted by (user-specified numeric column from the input table)

0 weighted uncorrected sum of squares weighted by (user-specified numeric column

from the input table)



58



59

APPENDIX

Required Components

The following list contains the components that are included in order to successfully
install and run SAS IT Resource Management 3.1.1:

o0 Third-party software:

0 MXG on SAS IT Resource Management 3.1.1 servers licensed and installed in
z/OS operating environments

0 NTSMF on SAS IT Resource Management 3.1.1 servers licensed and installed
on Windows
0 SAS IT Resource Management specific server and client software:
0 SAS IT Resource Management 3.1.1 software
0 SAS IT Resource Management adapters
O Supporting SAS Server, Middle Tier, Application Server, and Client software and
packages:
o Base SAS
SAS/SHARE
SAS/STAT
SAS/ETS
SAS/ACCESS (to Oracle, to DB2)

SAS/ACCESS to ODBC on SAS IT Resource Management servers licensed
and installed in Windows and UNIX operating environments

SAS Enterprise Guide
0 SAS Data Integration Studio
o SAS Enterprise Business Intelligence Server

O 0o o o o

O
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APPENDIX

Recommended Reading

The following titles are available at
http://support.sas.com/documentation/onlinedoc/index.html:

O

Administering SAS Enterprise Guide
0 SAS Data Integration Studio: User’s Guide

0 SAS Enterprise Guide Administrator: User’s Guide

0 SAS IT Resource Management: Administrator’s Guide

0 SAS IT Resource Management: Migration Documentation
Other titles of interest include the following documentation:

0 SAS 9.1.3 Intelligence Platform: Administration Documentation that is available
at http://support.sas.com/documentation/configuration/913admin.html.
This documentation includes SAS Management Console 9.1.3: User’s Guide

0 SAS Web Infrastructure Kit: Developer’s Guide that is available at
http://support.sas.com/rnd/itech/library/library9.html.
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A

Access Control Template (ACT)
modifying the default
accessibility
ad hoc reports ﬂ
Adapter Setup Wizard
generating aggregation tables
staging data
adapters ﬂ
staging data
supplied adapters
types of
admin library
aggregating staged tables ﬂ
aggregation tables
generating
Aggregation Tables folder
aggregation transformations ﬂ
aggregations
defining simple or summarized aggregations @
example
generating aggregation tables
applications data sources
architecture
client tier
middle tier
processing IT resource data
reference table of tasks
SAS Intelligence Platform
SAS Intelligence Platform components
server tier
AS/400 systems

C
client tier

collecting raw data E
consulting and training services
content mapping
defining
Create New SAS Stored Process Wizard
customized reports

data administrators [3

data marts
See IT data marts

data sources

creating report definitions
distributed systems data sources
documentation

accessing

for installation

SAS IT Resource Management

SAS System

‘Web-based

E
e-mail forum

H
Help

IMS systems
information consumers [3
information maps

creating

data sources

generating E
Information Maps folder
installation documentation
IT data marts

contents of

creating

IT resource data, processing

See processing IT resource data

J

Java 2 Software Development Kit, Standard Edition (J2SE
SDK)

Java servlet container

Jobs folder

L

Libraries folder
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Microsoft Office E, E,
Online Help for
reporting process

middle tier

New Object Wizard
creating IT data marts
staging data

0

Online Help
Other Tables folder

P
plug-ins
3

power analysts [}
processes
processing IT resource data

accessing Microsoft Office products

creating and accessing reports interactively

creating customized reports on the Web
introduction
preliminary tasks
usage scenarios
processing raw data ﬂ,
product documentation, Web-based
projects

R
raw data

See also adapters
collecting
processing (staging) ﬂ,

report definitions
creating
for summarized data E

reporting process
SAS Add-In for Microsoft Office
SAS Enterprise Guide
SAS Information Delivery Portal
SAS Web Report Studio

reports
ad hoc ﬂ
creating and accessing interactively
creating in SAS Enterprise Guide
creating in SAS Web Report Studio |49
customized, generating on the Web
viewing ﬂ

required components

resource data, processing
See processing IT resource data

roles

S

SAS/ACCESS

SAS Adapter for SAP

SAS Add-In for Microsoft Office E E,
Online Help

reporting process
SAS Application Services
SAS Business Intelligence Platform E
SAS/CONNECT Online Help
SAS/CONNECT server
SAS Data Integration Studio E,
Online Help
SAS Enterprise Guide E,
creating reports in
Online Help
reporting process
SAS Foundation Services
SAS Information Delivery Portal E,
reporting process
SAS Information Map Studio E,
Online Help
SAS Intelligence Platform
components
SAS IT Resource Management E
architecture
documentation
e-mail forum
plug-ins
processes [
reference table of tasks
required components
starting
SAS Management Console
Online Help
SAS Metadata Repository
SAS Metadata Server
SAS OLAP Cube Studio
SAS OLAP Server
SAS/SHARE Online Help
SAS/SHARE server
SAS Statistics and Econometric Time Series E
SAS Stored Process Server
SAS System documentation
SAS Web Infrastructure Kit
SAS Web Report Studio E, Ig,
creating reports in
Online Help
reporting process
SAS Workspace Server
Section 508 compliance
server tier
simple aggregations
Source Designer
spin library
spin tables
staged tables E
aggregating ﬂ,
definition
Staged Tables folder
staging code, user-written
staging data
Adapter Setup Wizard
adapters and
New Object Wizard
staging raw data ﬂ,
staging transformation
starting SAS IT Resource Management E
statistics
stored processes
creating

summarized aggregations @



summarized data
report definitions for E

T

task table
Technical Support
training and consulting services
transformations E
aggregation transformations ﬂ,
aggregations
staging transformation

u

UNIX systems data sources
usage scenarios
user groups

user-written staging code

users

v
viewing reports ﬂ

w

Web, generating customized reports on

Web-based product documentation
WebDAV

defining content mapping
Windows systems data sources

z

z/OS data sources
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Your Turn

We want your feedback.

0 If you have comments about this book, please send them to yourturn@sas.com.
Include the full title and page numbers (if applicable).

o0 If you have comments about the software, please send them to suggest@sas.com.
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